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Hinweise zu diesem Handbuch 

Mit diesem Handbuch erhalten Sie Hinweise und Informationen über die Funktion und Konfigura-
tion des MasterPort 2 PSU.  

 

Dieses Handbuch gilt für den MasterPort 2 PSU. Wie alle anderen Produkte aus dem Hause LSS 
GmbH unterliegt der MasterPort 2 PSU einer ständigen technischen Weiterentwicklung. Deshalb 
werden hier unter Umständen Funktionen und Einstellungen beschrieben, die für den von Ihnen 
genutzten MasterPort 2 PSU nicht verfügbar sind. 

Dieses Handbuch nutzt folgende Symbole, um für Sie wichtige Hinweise zu Ihrer Sicherheit und zur 
Konfiguration kenntlich zu machen. 

 

Hier erhalten Sie zusätzliche Informationen.  

 

 

Ein Achtung weist Sie auf Situationen hin, in denen Entscheidungen zu technischen 
Problemen mit dem Gerät oder zu Datenverlusten führen können. 

 

 

Eine Warnung bezeichnet Situationen, in denen Verletzungen oder Schäden für Leib 
und Leben auftreten können. 

 

 

Sicherheitshinweise 

Der Umgang mit dem MasterPort 2 PSU ist nicht gefährlich. Schutzisolierung und weitere Sicher-
heitsmaßnahmen verhindern zuverlässig, dass Sie mit gesundheitsschädlichen Spannungen und 
Strömen in Berührung kommen. Beachten Sie aber folgende Hinweise: 

 

 Nehmen Sie niemals sichtbar beschädigte Geräte in Betrieb! 

 Liegt der Verdacht auf einen Defekt vor, trennen Sie das Gerät sofort von der 
Stromversorgung! Sichern Sie das Gerät gegen Wiederinbetriebnahme! 

 Trennen Sie vor der Abnahme der Rückwand das Gerät unbedingt vom Netzteil! 

 Reparaturen dürfen nur von einem autorisierten Händler oder von Mitarbeitern der 
LSS GmbH durchgeführt werden. 
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Hinweise zur Handhabung 

Der MasterPort 2 PSU ist für einen 24h Dauerbetrieb konzipiert. Dennoch sollten Sie folgendes be-
achten:  

 

 Setzen Sie das Gerät nur zu seinem bestimmungsgemäßen Zweck ein! 

 Vermeiden Sie extreme mechanische Belastungen! 

 Vermeiden Sie jegliche mechanische Einwirkungen auf das Display! 

 Wenn nötig reinigen Sie das Display ausschließlich bei ausgeschaltetem Gerät. Be-
nutzen Sie nur ein angefeuchtetes Tuch 

 Vermeiden Sie direkte Nässeeinwirkung sowie übermäßige Hitzeeinwirkung auf das 
Gerät! 

 Decken Sie die Belüftungsöffnungen niemals ab! Brandgefahr! 

 Montieren Sie das Gerät nicht unmittelbar über Scheinwerfern! 
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Der MasterPort 2 PSU 
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Überblick 

 

Der MasterPort 2 PSU ist der Nachfolger des beliebten MasterPort PSU, der in vielen Lichtanlagen 
Europas zu finden ist. Mit der zweiten Generation erweitert LSS die Fähigkeiten des Netzwerkkno-
tens für Lichtnetzwerke mit Fähigkeit, als Spannungsversorger für Endgeräte in der Lichtanlage 
aufzutreten, erheblich. Neben dem Einsatz neuer, noch leistungsfähigerer CPUs fallen sofort die 
neuen Power-DMX-Ausgänge ins Auge.  

 

Wie gewohnt können auch mit dem MasterPort 2 PSU Ethernetdaten auf bis zu vier DMX-
Universes umgesetzt werden. Jedes Universe ist imstande, bis zu vier Sender nach dem HTP-
Prinzip zu mergen. Beim MasterPort 2 PSU werden diese Universen vor der Ausgabe in zwei DMX-
Ports gesplittet: Ein DMX-Port steht als reiner Datenausgang mit einem 5poligen XLR Port zur Ver-
fügung. Der zweite DMX-Port überträgt neben den Daten auch noch eine Spannungsversorgung in 
einem 4poligen XLR-Port. Das Besondere an dieser Konfiguration ist, dass jedes Universe so in zwei 
DMX-Ports zeitgleich ausgegeben werden kann, entweder als reines Daten-Universe oder als Da-
ten-Universe mit Spannungsversorgung. Dabei sind alle DMX-Ports RDM-ready nach ANSI E1.20 
2006.  

 

Mit den PSU-Ports können Endgeräte, wie zum Beispiel Farbwechsler, Motorbügel und LED-
Leuchten, mit 24 Volt und bis zu 5 Ampere pro Kanal versorgt werden. Die maximale Stromstärke 
ist für jeden DMX-Port individuell in 0,1 Ampere-Schritten einstellbar und eine permanente Strom- 
und Spannungsmessung überwacht die Leistungsabgabe bis hin zur Selbstabschaltung des DMX-
Kanals.  

 

Mit der neuen CPU sind die Konvertierungen von Lichtnetzwerkprotokollen von Ethernet nach 
DMX noch schneller ausgeführt. Dabei werden wie bisher die Protokolle ArtNet, sACN, AVAB/IPX, 
AVAB/UDP, ShowNet unterstützt. Daneben ist es mit dem MasterPort 2 PSU nun auch möglich, ihn 
in Art-Net3-Netzwerke zu integrieren.  

 

Wie viele andere Geräte aus dem Haus LSS auch, ist der MasterPort 2 PSU explizit für den Einsatz 
in Bühnennähe konzipiert. Das bedeutet, er ist passiv gekühlt und dadurch absolut geräuschlos, 
das Display zur Konfiguration ist abschaltbar und nicht zuletzt kann der LSS MasterPort 2 PSU voll-
ständig von der Software LSS ConfigCore fernkonfiguriert werden.  
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Unterstützte Protokolle 

Der LSS MasterPort 2 PSU unterstützt folgende Protokolle: 

 

 Art-Net  ShowNet 

 AVAB/UDP  AVAB/IPX 

 sACN  DMX512 

 

Anschlüsse 

 

Ethernet:  1x RJ45, 100MBit 

 

DMX:   Frontseite: 

4x DMX-Out XLR-5polig 

   4x Power-DMX-Out XLR-4polig 

   alle XLR DMX-Out sind elektrisch isoliert 

 

   Rückseite: 

   4x DMX-Out Sockelanschluss 4polig 

   4x Power-DMX-Out Sockelanschluss 4polig 

   Die rückseitigen DMX-Anschlüsse sind nicht elektrisch isoliert. 
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Funktionsübersicht 

DMX 

DMX-Ausgänge 

 

 

Gemeinsam für alle DMX-Ausgänge sind folgende Parameter einstellbar: 

 Verhalten bei Empfangsausfall aller Quellen (Abschalten, Halten, Nullen senden) 

 Breaklänge 90…999 µs 

 Mark After Break 20…999 µs 

 

Dadurch können Sie den MasterPort 2 PSU an jedes Endgerät anpassen. 

 

Der MasterPort 2 PSU kann nur als Protokollkonverter zwischen DMX und ethernetba-
sierenden Netzwerkprotokollen eingesetzt werden. Für Konvertierungen von Ethernet-
Protokollen muss ein LSS MasterGate eingesetzt werden! 

 

 

Ethernet 

Datentransferrate 

Der MasterPort 2 PSU zeichnet sich durch hohe Durchsatzrate und geringe Latenz (Verzögerungs-
zeit) in beiden Richtungen aus. Die Netzwerkschnittstelle ist 100MBit-fähig und die interne CPU 
arbeitet mit einem sehr schnellen Realtime-Multitasking-Betriebssystem. So ist ein maximaler 
Durchsatz von >1000 Netzwerk-Paketen pro Sekunde möglich. 

 

 

Netzwerkprotokolle 

Das Standard-Netzwerkprotokoll des MasterPort 2 PSU bei Auslieferung ist das herstellerübergrei-
fende Art-Net von ArtisticLicence. Die aktuell eingesetzte Protokollversion ist Art-Net III 1.4bd.  

 

Für AVAB Safari VLC, transtechnik NT oder zur Kommunikation mit Fremdgeräten von LDDE u.ä. 
wird das ältere Protokoll AVAB/IPX unterstützt. Für transtechnik NT – und ETC - Anlagen wird das 
Protokoll AVAB/UDP unterstützt, das einer direkten Umsetzung von AVAB/IPX auf TCP/UDP ent-
spricht. Für Anlagen der Firma Strand Lighting wird das ShowNet - Protokoll unterstützt. Daneben 
wird das Streaming-Protokoll sACN als Untermenge des ANSI-Standard E1.31 2009 unterstützt, das 
auf Multicast basiert. Der MasterPort 2 PSU benutzt hierfür IGMPv2. 
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Remotekonfiguration 

Für alle LSS-Geräte wird die kostenlose Software ConfigCore empfohlen, die alle Features des Mas-
terPort 2 PSU und anderer LSS-Geräte, aber auch Art-Net-Geräte anderer Hersteller unterstützt. 
Nur mit dieser Software ist es möglich, alle Geräte im Netzwerk aufzufinden und den MasterPort 2 
PSU komplett remote zu konfigurieren. 

 

Als Art-Net-kompatibles Gerät arbeitet der MasterPort 2 PSU problemlos mit Art-Net-
Softwaretools anderer Hersteller, wie z.B. dem Programm DMX-Workshop zusammen (Download 
unter www.artisticlicence.com). Selbstverständlich hat der MasterPort 2 PSU wie alle anderen Art-
Net-Geräte eine eigene OEM-ID (ab Workshop-Version 3.57 erkannt und unterstützt). Über dieses 
Tool ist auch eine eingeschränkte Remote-Konfiguration möglich. Beachten Sie, dass Art-Net hier 
nur eine Untermenge des MasterPort 2 PSU konfigurieren kann.  

 

Auch bei anderen eingestellten Licht-Protokollen als Art-Net ist der MasterPort 2 PSU 
mit ConfigCore immer konfigurierbar, es wird lediglich vorausgesetzt, dass der PC im 
IP-Adressbereich des MasterPort 2 PSU liegt. 

 

Licht-Parameter 

Für alle Lichtprotokolle können Sie folgende Parameter einstellen: 

 minimale Senderate ohne Werteänderung 20 ms … 4s 

 Timeout-Zeit 1...999 s (Halten usw. wird pro DMX-Out eingestellt, s. dort) 

 Timeout ist nur global einstellbar, wird aber für jedes verwendete Subnetz/Universe einzeln 
überprüft 

 

IP-Parameter 

Für alle auf TCP/IP basierenden Lichtprotokolle können Sie weiterhin folgende Parameter festle-
gen: 

 IP-Adresse  Manuell / Art-Net 2.x.x.x / Art-Net 10.x.x.x / DHCP 

 IP-Subnetz-Maske 

 Gateway-IP 

 

Merge-Verhalten 

Der MasterPort 2 PSU kann bei Anlagen, die auf dem gleichen Subnetz/Universe senden, bis zu 4 
Anlagen HTP-mergen. Dies zeichnet ihn von den meisten anderen Geräten dieser Art aus. Art-Net 
sieht z.B. hier nur 1 oder max. 2 Anlagen vor. 

Es werden ebenfalls Prioritäten unterstützt, wenn dies das Lichtprotokoll zulässt. Es werden aber 
keine herstellereigenen Erweiterungen, wie z.B. „Prioritäten pro Kreis“, unterstützt. 
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Anzeige-, Anschluss- und Bedien-
elemente 
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Frontseite 

Überblick 

Auf der Frontseide des LSS MasterPort 2 PSU befinden sich die DMX-Ports und der Konfigurations-
bereich. 

 

 

 

BetriebsLED 

 

 

Menüeinstellung 

 

 

 

DMX-Out 

 

 

 

Power 

DMX-Out 

 

 

 

 

 

 

Anschlüsse 

Die Anschlüsse des LSS MasterPort 2 PSU befinden sich direkt am Gerät. Alle DMX-Ports sind an 
der Frontseite angeordnet, der RJ45-Zugang und die Anschlüsse der externen Spannungsversor-
gung auf der Rückseite. Ebenfalls auf der Rückseite befinden sich sekundäre DMX-Ports, die im 
kommenden Hauptkapitel näher beschrieben werden. 

 

Die DMX-Ports und ihre zugehörigen Power-DMX-Ports stellen ein Universe mit parallel geschaltet 
Ports dar. So ist es möglich, den reinen DMX-Daten-Port und den DMX-PSU-Port gleichzeitig als ein 
Universe zu betreiben. 
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BetriebsLED 

Über die LEDs an der Frontseite werden die Betriebszustände des MasterPort 2 PSU angezeigt. 

 

LED Farbe Bedeutung 

Power blau Ein: Betriebsspannung vorhanden 

Aus: Betriebsspannung nicht vorhanden 

LINK/DATA gelb Ein: Ethernet-LINK, keine Daten 

Blinkt: Ethernet-LINK, Daten 

Aus: kein LINK 

ACTIVE/FAIL  Grün 
 
 
 
 
 
Rot 
 

DMX-Port-Sammelanzeige  
An: mindestens ein DMX-Port ist aktiv 
Blinkt: mind. ein DMX-Port erhält kein Signal und ist auf HOLD  
Blitzt: mind. ein DMX-Port erhält kein Signal und sendet NULL (ZERO) 
Aus: Alle DMX-Ports sind aus 
 
Fehlermeldungen 
Blinkt: Programmierfehler – Service informieren! 
An: Sammelfehler – Service informieren!  

PSU-Power grün Ein: Betriebsspannung vorhanden 

Blinkt: Betriebsspannung nicht vorhanden 

PSU-
Overload 

rot Ein: benötigte Ausgangsleistung zu hoch 

Aus: Ausgangsleistung innerhalb Parameter 

 

Im Gerät sind noch weitere Diagnose-LEDs vorhanden. Diese sind für Service und Wartung vorge-
sehen. 

 

Power Supply Unit (PSU) 

Der MasterPort 2 PSU kann mit DMX angesteuerte Endgeräte neben Daten auch mit der notwen-
digen Spannung versorgen. Dafür wird über die PSU-Ports eine Spannung von 24V übertragen und 
pro Port eine Stromstärke von bis zu 5A zur Verfügung gestellt. Für jeden Kanal kann die Aus-
gangsstromstärke in 0,1A-Schritten festgelegt werden und durch deren ständige Überwachung ist 
der MasterPort 2 PSU auch in der Lage, den Port bei Überlast selbstständig zu schließen. 

 

Mit einer eigenen DMX Adressierung für jeden PSU-Port ist der MasterPort 2 PSU aber auch in der 
Lage, diesen Port zu schalten. Das geht ganz einfach mit einem Signal vom Lichtpult aus. 
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Die Power Supply Unit wird ständig temperaturüberwacht. Im System sind eine Warntemperatur 
und eine Abschalttemperatur eingetragen, die nur werkseitig geändert werden können. Wird die 
Warntemperatur erreicht, erscheint auf dem Display eine Warnmeldung. Beim Erreichen der Ab-
schalttemperatur werden die Power-DMX-Ports automatisch abgeschaltet und es erscheint eine 
weitere Meldung im Display. Die Power-DMX-Ports bleiben solange abgeschaltet, bis die Tempera-
tur der Power Supply Unit 10°C weniger als die Warntemperatur beträgt. Die Abschaltung kann 
nicht manuell beendet oder umgangen werden. 
 

 

Menüeinstellung und Display 

Die Konfiguration des MasterPort 2 PSU erfolgt lokal über ein komfortables Menüsystem. Zu die-
sem Zweck enthält das Gerät ein blau-weiß leuchtendes 20x4 LCD-Display mit stromsparender 
LED-Hintergrundbeleuchtung und langer Lebensdauer. Die Lebensdauer wird noch um ein Vielfa-
ches erhöht, wenn der Bildschirmschoner verwendet wird.  

 

Bedient wird das Menü mit einem Dreh/Drück-Encoder, der bereits vom LSS PowerDim bekannt 
ist. 

 

 

 

 

 

Menübildschirm 

 

 

 

 

 

Dreh/Drück-Encoder 

 

Verwenden Sie den Bildschirmschoner! Dies verlängert die Lebensdauer des Displays um 
ein Vielfaches.  

 

Im Menü können Sie den Kontrast des Displays einstellen. Ein Nachregeln ist aber norma-
lerweise nicht nötig, da das Display bereits temperaturkompensiert ist. 
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Rückseite 

Überblick 

An der Rückseite des MasterPort 2 PSU befinden sich die Anschlüsse zur Spannungsversorgung des 
Gerätes und optionale sekundäre DMX-Ports. 

 

Spannungsver- 

sorgung Steuereinheit 

 

 

Ethernet 

 

 

 

 

 

 

Optionale rückseitige 

DMX-Out Anschlüsse 

 

Spannungsver- 

sorgung PSU 

 

Optionale rückseitige 

Power-DMX-Out-Anschlüsse 

 

 

Spannungsversorgung Steuereinheit 

Die Spannungsversorgung der Steuereinheit des MasterPort 2 PSU kann wahlweise per Power-
over-Ethernet (PoE) oder mit einem externen Netzteil (24V DC) erfolgen. Bei PoE erfolgt die Span-
nungsversorgung direkt über den Ethernet-Anschluss. Wird ein externes Netzteil eingesetzt, er-
folgt die Spannungsversorgung der Steuereinheit über den oberen grünen Phoenix-
Steckverbinder. 

 

Wird die Steuereinheit des MasterPort 2 PSU sowohl über PoE als auch über ein externes 
Netzteil mit Spannung versorgt, hat die Versorgung über PoE Priorität! 
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Ethernet 

Der MasterPort 2 PSU ist mit einer RJ-45-Ethernet-Schnittstelle ausgerüstet, die eine IEEE-
Belegung für 100BaseTx und Power-over-Ethernet (PoE) gemäß Standard IEEE 802.3af unterstützt.  

 

 

Spannungsversorgung PSU 

Die Spannungsversorgung der MasterPort 2 PSU kann wahlweise durch ein externes Netzteil  oder 
durch eine zentrale Spannungsversorgung (jeweils 24V DC, 20A) erfolgen, nicht aber durch PoE. 
Für jeweils zwei Power-DMX-Anschlüsse steht ein Phoenix-Steckverbinder zur Verfügung.  

 

 

Optionale rückseitige DMX-Anschlüsse 

Auf besonderen Wunsch (als Bestelloption) können die vorderen vier DMX-Anschlüsse auch rück-
seitig als 4pin-Steckanschlüsse ausgeführt werden. Diese sekundären DMX-Anschlüsse sind zu den 
XLR-Anschlüssen parallel geschaltet und entsprechen in der Software-Konfiguration immer ihrem 
vorderseitigen Pendant.  

 

Diese DMX-Anschlüsse sind nicht elektrisch isoliert! 

 

Die Bestückung mit Anschlusspins ist eine Bestelloption und kann nicht nachträglich reali-
siert werden! 

 

Optionale rückseitige Power-DMX-Anschlüsse 

Ebenso wie die reinen DMX-Datenanschlüsse können auch die Power-DMX-Anschlüsse rückseitig 
als sekundäre Anschlüsse ausgeführt werden. Sie sind parallel zu den frontseitigen Power-DMX-
Anschlüssen geschaltet und entsprechen in der Software-Konfiguration den jeweiligen vorderseiti-
gen XLR-Anschlüssen. Es gilt zu beachten, dass die mitgelieferten Crimp-Steckverbinder nur bis zu 
einem maximalen Nennstrom von 3A zugelassen sind. 

 

 

Diese Power-DMX-Anschlüsse sind nicht elektrisch isoliert! 

 

Die mitgelieferten Crimp-Steckverbinder sind nur für einen maximalen Nennstrom von 3A 
ausgelegt! 

 

Die Bestückung mit Anschlusspins ist eine Bestelloption und kann nicht nachträglich reali-
siert werden!  
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Konfiguration des MasterPort 2 PSU 
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Hinweise zur Bedienung des Menüs 

Aufbau und Auswahl 

Die Menüstruktur des MasterPort 2 PSU ist hierarchisch angeordnet. Die erste Ebene ist der 
Grundzustand, von dem der Zugriff auf das Hauptmenü erfolgt. Vom Hauptmenü sind die weiteren 
Untermenüs thematisch in Ebenen unterteilt.  

 

Menüauswahl 

Drehen am Encoder wählt die unterschiedlichen Menüpunkte und Schaltflächen durch ein wan-
derndes ►. Ein kurzes Drücken auf den Encoder öffnet diesen Menüpunkt oder bestätigt die EIn-
stellung. 

 

Ändern von Einstellungen 

Der ausgewählte Parameter wird mit einem  invers blinkenden  ersten Zeichen dargestellt und 
kann nun durch Drehen am Encoder verändert werden. Erneutes Drücken übernimmt die Einstel-
lung, die veränderten Parameter werden dann sofort wirksam. 

 

Das Bestätigen der Schaltfläche „◄“ führt die MasterPort 2 PSU-Steuereinheit in das übergeord-
nete Menü zurück. Bevor dieses Menü angezeigt wird, werden Sie gefragt, ob Sie die geänderten 
Parameter speichern möchten.  

 

Speichern von Parametern 

Möchten Sie eingestellte Parameter speichern, wählen und bestätigen Sie die Nachfrage mit „Yes“. 
Die geänderten Werte werden dauerhaft gespeichert. Mit „No“ kehren Sie in das vorhergehende 
Menü zurück, geänderte Werte werden nicht gespeichert, auch wenn sie bereits temporär einge-
stellt waren. 

 

Wird über einen einstellbaren Zeitraum der Encoder nicht betätig, wird der Grundzustand akti-
viert. Dabei wird das Gerät wieder gegen unbefugte Bedienung verriegelt und das eingegebene 
Passwort gelöscht. Nicht gespeicherte Änderungen im aktuell geöffneten Menü gehen verloren. 
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Legende zur Schematische Darstellung des Menüs 

Der Aufbau des Menüs und die Konfigurationsmöglichkeiten werden im Folgenden schematisch 
dargestellt. Die verwendeten Symbole haben folgende Bedeutung: 

 

Symbol Bedeutung 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Display-Anzeige 

 

Anzeigenname 

 

 

 

 

 

 

Anzeigen/Parameter zur Auswahl 

 

 

 

 Auswahl durch Drehen des Encoders 

 Bestätigen durch Drücken des Encoders 

 Stellt dar, zu welcher Display-Anzeige Auswahl führt 
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Grundzustand 

 

Im Grundzustand scrollt das Menü des MasterPort 2 PSU durch verschiedene Diagnoseseiten. Die-
se Seiten geben einen schnellen Überblick über verschiedene Einstellungen und den Betriebszu-
stand des Geräts.  

 

Es ist möglich, den automatischen Scroll durch Drehen des Encoders zu unterbrechen und durch 
weiteres Drehen manuell die Seiten aufzurufen. Der automatische Scroll wird mittels eines blin-

kenden -Symbols rechts oben angezeigt. Beim Wechsel zum manuellen Scroll ändert sich das 
Symbol in II. 
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Hauptmenü 

PIN-Abfrage 

Vom Hauptmenü aus werden alle anderen Menüs, wie Anzeige-, Konfigurations- und weitere Ein-
stellungsmenüs aufgerufen. Falls eine PIN vergeben wurde, wird diese vor dem Hauptmenü abge-
fragt: 

 

 
 

Die Eingabe der Pin erfolgt mit dem Encoder. Zur Sicherheit wird vor und nach dem Scrollen nur 
[*****] angezeigt. 

 

Aufbau Hauptmenü 

Vom Hauptmenü aus werden alle anderen Menüs aufgerufen. Um vom Grundzustand aus das 
Hauptmenü aufrufen zu können, muss die Taste „MENU“ gedrückt werden.  

Das Hauptmenü ist unterteilt in Monitoring-Menüs, Konfigurationsmenüs und weitere Einstellun-
gen. 

 

 
 

Auswahl Bedeutung 

View Auswahl der Netzwerk- und DMX-Monitore 

Config Auswahl des Menüs zur Einstellung des MasterPort 2 PSU 

Options Auswahl des Menüs zur Einstellung der Zusatzfunktionen 

◄ Zurück in Grundzustand. 
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View-Menü 

Mit den Monitoren im View-Menü erhalten Sie einen Überblick über die aktuellen Einstellungen 
des MasterPort 2 PSU. Aktuelle Ereignisse, Daten-In- und –Output werden ebenso dargestellt wie 
die Merge-Situation. Die Anzeigen im View-Menü verstehen sich als Monitore und sind in Echtzeit. 
Dadurch lassen sie sich problemlos als Überwachungs- und Diagnosetools einsetzen. 

 

Aufbau des View-Menüs 
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View→DMX 

Dieser Monitor gibt einen Überblick über die Aktivitäten an den DMX-Ports. Im Untermenü für alle 
Ports können die Signale für jedes Bit hexadezimal oder prozentual dargestellt werden.  

 

Dieser Monitor gibt einen Überblick über die Aktivitäten an den einzelnen DMX-Ports. Für jeden 
Port kann ein Untermenü aufgerufen werden, das die Signale für jedes Bit hexadezimal oder pro-
zentual darstellt. 

 

Anzeige Bedeutung 

DMX 1…4 DMX-Port 1…4 

IN Das Symbol ist nur bei DMX-In Ports vorhanden. 

voll: am DMX-Eingang wird ein korrektes DMX-Protokoll empfangen 

E: DMX-Protokoll an dem Eingang ist ungültig (Startcode oder Timing) 

leer: kein Signal am DMX-Eingang 

OUT Das Symbol ist nur bei DMX-Out Ports vorhanden. 

voll: am DMX-Ausgang wird DMX gesendet 

H: DMX-Ausgang ist auf HOLD und hält die letzten Daten 

Z: DMX-Ausgang ist auf HOLD und sendet Nullprotokolle 

leer: DMX-Ausgang ist abgeschaltet 

Cnt Anzeige der gesendeten Pakete pro Sekunde. 

F Anzeige der Framerate pro Sekunde 

► Untermenü aufrufen 

◄ Rückkehr ins übergeordnete Menü 
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View→Network 

View→Network→Monitor 

 

In diesem Monitor werden die aktuellen Einstellungen an den DMX-Ports angezeigt.  

 

Anzeige Bedeutung 

1…4 DMX 1…4 

Act voll: auf dieser Subnet/Universe-Kombination wird Licht empfangen 

leer: auf dieser Subnet/Universe-Kombination wird kein Licht empfangen 

Sub logisches Subnet (lichtprotokollabhängig) 

Wenn der DMX-Port im Routing abgeschaltet ist oder das gewählte Licht-
protokoll keine Subnets kennt, wird „-“ angezeigt. 

Uni Universe (lichtprotokollabhängig) 

Wenn der DMX-Port im Routing abgeschaltet ist oder das gewählte Licht-
protokoll keine Universes kennt, wird „-“ angezeigt. 

► Untermenü aufrufen 

◄ Rückkehr ins übergeordnete Menü 

 

 

View→Network→Counter 

Dieses Auswahlmenü führt zu Monitoren, die einen Überblick über eingehende und ausgehende 
Daten und Datenpakete geben. Die Monitore geben ihre Informationen sehr umfangreich wieder, 
so dass man diese Informationen durchaus zur Netzwerkdiagnose nutzen kann. 

 

Anzeige Bedeutung 

In Aufruf Netzwerkzähleranzeigen für empfangene Daten 

Out Aufruf Netzwerkzähleranzeigen für gesendete Daten 

Data Aufruf Netzwerkzähler für Datenpakete 

► Menü aufrufen 

◄ Rückkehr ins übergeordnete Menü 
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View→Network→Counter→In/Out 

 

Anzeige Bedeutung 

kByte empfangene kByte 

Packets empfangene Pakete 

Errors Summe der Empfangsfehler 

Dropped Empfangsüberlauf durch zu viele Pakete 

Overrun (nur In) Empfangsüberlauf durch zu viele Pakete 

Aborted (nur Out) Abgebrochene Pakete 

Length (nur In) Pakete mit Längenfehler 

Carrier (nur Out) Ethernet-Carrier verloren 

CRC (nur In) CRC-Empfangsfehler 

Heartbt (nur Out) Ethernet Heartbeat verloren 

Frame Frame Fehler 

FIFO Überlauf Ethernet FIFO 

Diff0 Zähler der Paketverluste im Netzwerk 

Diff1 Zähler der Paketverluste im Netzwerk 

Diff2 Zähler der Paketverluste im Netzwerk 

Diff3 Zähler der Paketverluste im Netzwerk 

◄ Rückkehr ins übergeordnete Menü 

 
 

View→Network→Counter→Data 

 

Anzeige Bedeutung 

Rx Empfangene Datenmengen 

Tx Gesendete Datenmengen 

Pack./s Pakete pro Sekunde 

kByte Datenmenge in kByte 

◄ Rückkehr ins übergeordnete Menü 
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View→PSU 

Dieses Auswahlmenü führt zu Monitoren, die einen Überblick über Strom- und Spannungsversor-
gung an den PSU-Ports geben. Für jeden PSU-Port ist ein eigener Monitor vorhanden. 
 

Anzeige Bedeutung 

Port 1 Aufruf Monitor für PSU-Port 1 

Port 2 Aufruf Monitor für PSU-Port 2 

Port 3 Aufruf Monitor für PSU-Port 3 

Port 4 Aufruf Monitor für PSU-Port 4 

► Monitor aufrufen 

◄ Rückkehr ins übergeordnete Menü 

 

View→PSU→Port x 

Anzeige Bedeutung 

Zeile 2 

x.x V (links) Anzeige PSU Eingangsspannung 

x.x V (Mitte) Anzeige Spannung am PSU-Port 

x.x A Anzeige Laststrom  

x.x A! Anzeige Laststrom nähert sich voreingestellter Schaltschwelle  

Zeile 3 

Mode Anzeige der eingestellten Aktion beim Erreichen der Schaltschwelle 

On/Off (rechts) Anzeige des aktuellen Schaltzustands des PSU-Ports 

Zeile 4 (folgende Anzeigen treten nie zeitgleich auf) 

No load Es liegt keine Last an. Alle Spannungen sind innerhalb der Parameter. 

Normal load Eine Last ist am PSU-Port angeschlossen. PSU-Port arbeitet innerhalb der 
eingestellten und zulässigen Parameter. 

24V supply failure PSU-Spannungsversorgung liegt nicht an 

24V out of range! Die anliegende PSU-Spannung ist außerhalb der werkseitig voreingestell-
ten Parameter. Netzteil prüfen! 

24V from outside! Rückspeisung der Spannungsversorgung von außen. Verbindung prüfen! 

Current Overload Der Laststrom hat die voreingestellte Schaltschelle erreicht oder der Last-
strom war höher als 5A. Der PSU-Port wurde automatisch deaktiviert. 

Short / Overtemp! Ein Kurzschluss liegt vor oder eine Temperatur über den Sicherheitspara-
metern wurde gemessen. Der PSU-Port wurde automatisch deaktiviert. 

◄ Rückkehr ins übergeordnete Menü 
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Config-Menü 

Möglichkeiten des Configuration-Menüs 

Im Config-Menü können Sie die vielfältigen Einstellungsmöglichkeiten des MasterPort 2 PSU kom-
fortabel ändern. Zu Ihrer eigenen Sicherheit müssen Sie vor jeder Änderung der Einstellungen die-
se Änderung auch bestätigen.  

 

Bitte beachten Sie, dass jede Änderung der Einstellungen weitreichende Folgen auf Ih-
re Lichtanlage haben kann. Die folgend beschriebenen Einstellungsmöglichkeiten set-
zen auch voraus, dass Sie Erfahrungen und Kenntnisse in der Konfiguration von DMX 
und von Ethernet-Lichtprotokollen besitzen.  

 

Aufbau des Config-Menüs 

 

 
 

Menü Einstellungsmöglichkeiten 

Routing Einstellung des Merge-Verhaltens 

DMX Einstellung des Verhaltens der DMX-Ausgänge bei Signalverlust 

Network Einstellung der Ethernet-basierenden Netzwerkprotokolle 

PSU Einstellung der Netzparameter und des Überlastschutzes 

► Menü aufrufen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 

  



MasterPort 2 PSU 

 

LSS 
31 

 

 

 

Config→Routing 

Im Routing findet die Zuordnung der DMX-Ports zu den Ethernet Universes und Subnets statt. Au-
ßerdem wird hier festgelegt, was gemergt wird und ob der Port überhaupt aktiv ist. 

 

 

 
 

Anzeige Bedeutung 

Port 1 Einstellungen für Port 1 

Port 2 Einstellungen für Port 2 

Port 3 Einstellungen für Port 3 

Port 4 Einstellungen für Port 4 

► Menü aufrufen 

◄ Rückkehr ins übergeordnete Menü 
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Auswahl Bedeutung 

Mode Off: Ethernet wird nicht empfangen, DMX-Out abgeschaltet 

 

Single:  

Es werden nur die vom ersten Sender empfangenen Lichtdaten verwen-
det. Sollten gleichzeitig von mehreren Sendern Telegramme mit dem ein-
gestellten Subnetz und Universe anliegen, wird nur der als erstes er kann-
te Sender berücksichtigt. Die Sender-Erkennung erfolgt bei AVAB/IPX di-
rekt durch Auswertung der MAC-Adresse (Ethernetadresse), bei sACN 
nach der Geräte-ID und bei allen anderen Protokollen durch die IP-
Adresse des Senders, die für jeden Sender individuell sein muss. Bei Aus-
bleiben des Sendersignals wird nach der Timeout-Zeit (Pufferzeit) ggf. ein 
anderer Sender ermittelt (Prinzip: „Der erste darf“). 

 

Merge4: 

Es werden die Daten von bis zu 4 Ethernet-Sendern nach dem HTP-Prinzip 
zusammengefasst. Sollten gleichzeitig von mehr als 4 Sendern Telegram-
me mit dem Subnetz und Universe dieses Ausgangs anliegen, werden nur 
die ersten 4 erkannten Sender berücksichtigt. Bei Ausbleiben eines Sen-
dersignale wird nach der Timeout-Zeit ggf. ein anderer Sender ermittelt 
(Prinzip: „wer zuerst kommt“). 

Universe Einstellung des Sende-Universes (lichtprotokollabhängig) 

Subnet Einstellung des Sende-Subnets (lichtprotokollabhängig) 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 

 

 

Bei Protokollen mit Prioritäten gibt es folgende Besonderheiten: 

Protokoll Prioritätsbehandlung 

AVAB/UDP Bei Priorität  1…200 gewinnt die Anlage mit dem höchsten Prioritätswert. 

Mehrere gleiche der höchsten Priorität werden HTP- gemergt. 

Anlagen, die 0 senden (alte transtechnik-Versionen, DigiPlus usw.) wer-
den immer mit der höchsten Priorität zusammen HTP-gemergt. 

sACN Bei Priorität  1…200 gewinnt die Anlage mit dem höchsten Prioritätswert. 

Mehrere gleiche der höchsten Priorität werden HTP- gemergt. 

Anlagen, die 0 senden, werden wie Priorität 100 behandelt. 
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Config→DMX 

In diesem Menü werden das Verhalten der DMX-Out bei Empfangsausfall sowie das Timing des ge-
sendeten DMX-Protokolls festgelegt. 

 

 
 

Anzeige Bedeutung 

Failure Off:  bei Empfangsausfall wird der DMX-Out abgeschaltet 

Hold:  letzter empfangener Wert wird unverändert weitergesendet 

Zero:   bei Empfangsausfall werden Datenpakete mit dem Wert „0“ ge-
  sendet 

Break Einstellung der Breaklänge von 90…999 µs 

MAB Einstellung der Mark-after-Break-Länge von 20…999 µs 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→Network 

Im Network-Menü werden die auf dem Ethernet basierenden Netzwerkprotokolle eingestellt. 
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Anzeige Bedeutung 

Rx Prot Einstellung des Lichtprotokolls beim Datenempfang: 

 Art-Net  ShowNet 

 AVAB/IPX  sACN 

 AVAB/UDP  
 

Rx Tmo Einstellung des Timeouts beim Datenempfang 1…999 s   

Tx Prot Einstellung des Sendenetzwerkprotokolls: 

 Art-Net  ShowNet 

 AVAB/IPX  sACN 

 AVAB/UDP  
 

Tx Rate Einstellung der Mindest-Senderate für Lichtprotokolle, wenn sich keine Werte än-
dern:  20ms, 40ms, 80ms, 100ms, 200ms, 500ms, 1s, 2s, 3s, 4s 

IP Mode Bezug der IP-Adresse: 

Manual:  freie Einstellmöglichkeit 

Art-Net 2:  Art-Net-Adresse im 2er Netz 

Art-Net 10:  Art-Net-Adresse im 10er Netz 

DHCP:   wenn DHCP-Server im Netzwerk vorhanden 

IP IP-Adresse   die manuelle Eingabe ist nur bei „IP Mode = Manual“ möglich 

SN Netzwerkmaske die manuelle Eingabe ist nur bei „IP Mode = Manual“ möglich 

GW Gateway  eine Änderung einer voreingestellten Adresse ist nur in  
   Ausnahmefällen notwendig 

Name Einstellung des Art-Net ShortName zur Benennung des MasterPort 2 PSU ; z.B. 
Standort „Hinterbühne“ 

sACN 
Draft 

Auswahl des unterstützen sACN-Protokolls 

Off   MasterPort 2 PSU sendet sACN nach Standard E1.31 2009 

On   MasterPort 2 PSU sendet sACN nach Standard E1.31 R0 Draft 

Art-Net 
BC 

Art-Net wird als Broadcast gesendet. Dies ist bei der Ansteuerung von ADB-Anlagen 
notwendig. 

Art-
Net3Nw 

Einstellung der Art-Net3 IP-Adresse.  

0:   Art-Net3 ist deaktiviert 

1  127:   Art-Net3 ist aktiv und Ziffer gibt die IP-Adresse an. 
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Anzeige Bedeutung 

UDPChksm Einstellung zur Berechnung der Prüfsummen von UDP-Datenpaketen 

Rx & Tx  Prüfsummen für empfangene und gesendete Pakete 

Rx only   Prüfsummen nur für empfangene Pakete 

Tx only   Prüfsummen nur für gesendete Pakete 

Off   Prüfsummenberechnung aus 

EthMedia Einstellung der Übertragungsgeschwindigkeit 

Autoneg.  Automatische Ermittlung der Übertragungsgeschwindigkeit 

10 Half   10MBit/s Half Duplex 

10 Full   10MBit/s Full Duplex 

100 Half  100MBit/s Half Duplex 

100 Full  100MBit/s Full Duplex 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→PSU 

Alle vier PSU-Ports werden ständig strom- und spannungsüberwacht. In diesem Menü können Sie 
die Abschaltschwelle für Überwachung der Stromstärke und das Schaltverhalten MasterPort 2 PSU 
im Falle des Überschreitens dieser Schaltschwelle festlegen.  

 

 
 

Anzeige Bedeutung 

Port 1 Aufruf der Einstellungen für PSU-Port 1 

Port 2 Aufruf der Einstellungen für PSU-Port 2 

Port 3 Aufruf der Einstellungen für PSU-Port 3 

Port 4 Aufruf der Einstellungen für PSU-Port 4 

► Menü aufrufen 

◄ Rückkehr ins übergeordnete Menü 
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Config→PSU→Port x 

 

Auswahl Bedeutung 

Switch Einstellen des Schaltverhaltens  

On:  Servicemodus! Nicht im normalen Betrieb nutzen! 

Sense:  Der Power-DMX-Port wird automatisch abgeschaltet, wenn 
  die eingestellte Begrenzung der Stromstärke oder die  
  maximale Stromstärke von 5A überschritten wird. Die  
  manuelle Einstellung des Grenzwertes wird im Untermenü 
  MaxCurr eingestellt. 

DMX:  Hier wird die DMX-Adresse festgelegt, über die der Power-
  DMX-Port angesteuert wird. Die Stromüberwachung ist  
  aktiv und entspricht den Einstellungen aus "Sense". 

Off:  Der Power-DMX-Port ist manuell ausgeschaltet. 

 

Rücksetzen der Stromüberwachung ist mit kurzzeitigem Aus- und Ein-
schalten des DMX-Kreises von Fern möglich. 

MaxCurr Einstellung der Schaltschwelle für die Stromüberwachung. Die Einstellung 
erfolgt in 0,1A Schritten. 

DMX Channel Einstellung der DMX-Adresse für die Steuerung des Power-DMX-Port. 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 

 
 
 

Der Betrieb mit der Switch-Einstellung „On“ ist ausschließlich für den Service vorge-
sehen! Ein dauerhafter Betrieb mit mehr als 5A Dauerlast kann zur Zerstörung des 
MasterPort 2 PSU und der gesamten Lichtanlage führen! 

 
Einstellung Sense: Wurde die eingestellte Stromstärke überschritten und der Mas-
terPort 2 PSU automatisch abgeschaltet, muss ein manueller Reset unter Opti-
ons→Reset zum Neustart durchgeführt werden. Alle Einstellungen bleiben dabei 
erhalten.  
 
Einstellung DMX: Wurde die eingestellte Stromstärke überschritten und der Mas-
terPort 2 PSU automatisch abgeschaltet, wird die Stromüberwachung durch ein 
kurzzeitiges Aus- und Einschalten des DMX-Kreises aus der Ferne zurückgesetzt. Alle 
Einstellungen bleiben dabei erhalten. 
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Options 

Im Menü Options werden die Zusatzeinstellungen des MasterPort 2 PSU festgelegt. 

 

Aufbau des Menüs Options 

 

 
 

Menü Einstellungsmöglichkeiten 

Display Einstellung des Displays 

Security Einstellung der Sicherheitseinrichtung 

Default Laden von Default-Werten 

Reset Reset der Steuer-CPU 

► Menü aufrufen/Funktion ausführen 

◄ Rückkehr ins übergeordnete Menü 
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Options→Display 

Hier werden die Einstellungen für das Display festgelegt. 
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Auswahl Bedeutung 

Contrast Einstellung des Kontrasts des Displays 

MenuTimeout Timeout für Verlassen des Menüs bei Nichteingabe und Rückkehr zum Grund-
zustand 

(OFF, 15s, 30s, 1m, 3m, 5m, 10m, 15m, 20m, 30m, 45m, 1h, 2h, 3h, 4h, 6h, 8h, 
12h, 24h) 

ScreenSaver Timeout für Backlight-Abschaltung des Displays. Die Abschaltung des Back-
lights erhöht die Lebensdauer des Displays erheblich.  

Eingaben am Encoder, per Remote-Steuerung oder Events beenden den Zu-
stand. 

(OFF, 15s, 30s, 1m, 3m, 5m, 10m, 15m, 20m, 30m, 45m, 1h, 2h, 3h, 4h, 6h, 8h, 
12h, 24h) 

Events On:  Statusänderungen an DMX-In/Out oder Ethernet schalten 
  Bildschirmschoner aus und zeigen die jeweilige Statusseite  

Off:  Statusänderungen wirken sich nicht auf Bildschirmschoner 
  aus 

Debug On:  Schaltet den Debugger ein 

Off:  Schaltet den Debugger aus 

Default Definierung einer dem Grundzustand übergeordneten Anzeige 

Scroll:  Grundzustand scrollt normal  

UserTxt: Anzeige eines selbstformulierten Textes. Bei Aktivierung wird 
  unterhalb der Zeile eine weitere Eingabemaske zur Texteingabe 
  angezeigt. 

FixScoll: Eine bestimmte Diagnoseseite aus dem “First Level” wird  
  dauerhaft angezeigt. Wenn aktiviert, wird unterhalb der Zeile 
  eine Auswahl der Seiten eingeblendet. 

  1: Serial – Zeigt Geräte- und Softwaredetails an 

  2:  Counters – Zeigt Zähler und Messdaten an 

  3: NW-Info – Zeigt Etherneteinstellungen an 

  4: N-In – Überblick über empfangene Ethernetdaten 

  5: DMX – Überblick über gesendete DMX-Daten 

  6: PSU-State – Zeigt Ausgangsspannung und -strom an 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 
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Aufbau der anderen Untermenüs 

 

 
 

Options→Security 

In diesem Menü werden die Sicherheitseinstellungen festgelegt. 

Auswahl Bedeutung 

Pin Hauptmenü-Pin 

0…30000s (0 = aus) 

Remote On: MasterPort 2 PSU ist per Art-Net programmierbar 

Off: MasterPort 2 PSU ist nicht per Art-Net programmierbar 

► Parameter einstellen 

◄ Rückkehr ins übergeordnete Menü/Parameter speichern 

 

Obwohl das System eine Auswahl aus 30.000 möglichen Pins bietet, kann eine abso-
lute Sicherheit nicht gewährleistet werden! Treffen Sie geeignete Maßnahmen vor 
Ort, um einen nicht autorisierten Zugriff zu verhindern! 
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Options→Factory Defaults  

Hier werden alle Einstellungen der Steuereinheit des MasterPort 2 PSU auf die Werkseinstellungen 
zurückgesetzt.  Um einen Datenverlust vorzubeugen, ist eine doppelte Bestätigung zum Laden der 
Default-Werte notwendig.  

 

Parameter Bedeutung 

No Abbruch des Rücksetzens 

Yes Rücksetzen der Einstellungen auf Werkseinstellungen gemäß letztes Firmware-
Update 

► Ausführen 

◄ Rückkehr ins übergeordnete Menü 

 

 

Options→Reset 

Mit der Anwahl dieses Menüpunktes wird ein CPU-Reset ausgelöst. Nach dem Reset werden die 
gespeicherten Parameter geladen.  

Beim Ändern folgender Einstellungen führt der MasterPort 2 PSU nachfolgend automatisch einen 
Reset aus: 

 Lichtempfangsprotokoll  Lichtsendeprotokoll 

 IP-Mode  IP-Adresse 

 Netzwerkmaske  Gateway 

 Defaultwerte laden  
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Konfiguration mit ConfigCore 
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Konfigurationssoftware ConfigCore 

Die Konfiguration der LSS MasterPort 2 PSU kann auch über die Konfigurationssoftware LSS ConfigCore 
erfolgen. ConfigCore steht als kostenlose Software auf der Homepage der LSS als Download zur Verfü-
gung.  

 

Um ConfigCore mit einem MasterPort 2 PSU zu verbinden, muss der PC, auf dem ConfigCore aus-
geführt wird, in das gleiche Subnet gebracht werden, in dem sich auch der MasterPort 2 PSU be-
findet. Die Vorgehensweise zur Änderung von IP-Adressen und Subnets wird vom Anbieter des Be-
triebssystems zur Verfügung gestellt.  

 

 

Verbinden des MasterPort 2 PSU mit ConfigCore 

Befinden sich der PC mit ConfigCore und der MasterPort 2 PSU in einem Subnet und sind mitei-
nander über Ethernet verbunden, wird der MasterPort 2 PSU sofort von der Software erkannt. 

 

 

 

 

Gerätefenster 

 

 

 

 

Einstellungsfenster 

 

 

 

 

Gerätefenster 

Im Gerätefenster werden alle Geräte aufgelistet, die ConfigCore gefunden hat. Geräte von LSS er-
halten vor der IP-Adresse ein „+“. Mit einem Klick auf dieses Symbol wird ein Menübaum geöffnet, 
welcher Zugang zu speziellen Einstellungsoptionen ermöglicht. 

 

Eigenschaftsfenster 

Im Einstellungsfenster werden alle Einstellungen des im Gerätefenster ausgewählten Gerätes an-
gezeigt.  
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Statuspanel 

Für den MasterPort 2 PSU zeigt das unter dem Gerätefenster dargestellte Statuspanel die Parame-
ter Empfangsprotokoll, Remote-IP, Masteradresse, Geräteanzahl und Anzahl der Geräte in Daten-
austausch an.  

 

 

 

 

 

 

 

 

Statuspanel 
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ConfigCore Menüs  

Mit Klick auf das Zeichen „+“ vor dem Gerät im Gerätefenster, wird ein Menübaum mit Unterme-
nüs aufgerufen. Die Untermenüs sind rot eingefärbt. Je nach gewähltem Menü werden unter-
schiedliche Einstellungsmöglichkeiten im Einstellungsfenster angezeigt.  

 

Hauptmenü 

Im Hauptmenü dient dazu, einen Überblick über die grundlegen Eigenschaften zu geben. Ausge-
graute Eintragungen dienen der Information. Es können nur die Art-Net Kurz- und Langnamen ge-
ändert werden. Dazu müssen die Namenszeilen angeklickt und der neue Name eingetragen wer-
den. Mittels des Buttons „Update“ werden die Änderungen übernommen. 
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Erweiterte LSS Device Features 

Das Untermenü "Erweiterte LSS Device Features" beinhaltet alle Konfigurationsparameter, die 
auch aus dem internen Menü des MasterPort 2 PSU bekannt sind. 

 

 
 

 

Routing 

Das Untermenü Routing entspricht dem Menüpunkt Config→Routing. Hier findet die Zuordnung 
der DMX-Ports zu den Ethernet Universes und Subnets statt. Außerdem wird hier festgelegt, was 
gemergt wird und ob der Port überhaupt aktiv ist. 

Das Menü ist unterschiedlich, je nachdem ob der DMX-Port ein IN oder OUT ist. 
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DMX-In 

Werden am DMX-In Daten empfangen, sendet der MasterPort 2 PSU diese auf dem eingestellten 
Subnet/Universe (mit dem eingestellten Sende-Licht-Protokoll) aus, falls der Mode auf „On“ steht. 
Bei „Off“ wird nichts gesendet.  

 

 

 
 

 

Auswahl Bedeutung 

Mode Off: Ethernet wird nicht gesendet, DMX-In abgeschaltet 

On: Ethernet wird gesendet, wenn DMX-In aktiv 

Universe Einstellung des Sende-Universes (lichtprotokollabhängig) 

Subnet Einstellung des Sende-Subnets (lichtprotokollabhängig) 

Priorität Einstellung der Sende-Priorität (lichtprotokollabhängig) 
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DMX-Out 

Der DMX-Out ist aktiv, wenn der MasterPort 2 PSU über Ethernet mindestens eine Anlage auf dem 
eingestellten Subnet/Universe empfäangt. Bei bis zu 4 gleichen Quellen werden alle nach dem 
HTP-Prinzip zusammengefasst. Fällt der letzte aktive Sender aus, wird nach Verstreichen des Licht-
Empfangstimeouts der Out abgeschaltet bzw. bei „HOLD“ der letzte Wert gehalten oder bei „Zero“ 
Nullen gesendet. 

 

 
 

Auswahl Bedeutung 

Ethernet 
Merge 

Off: Ethernet wird nicht empfangen, DMX-Out abgeschaltet 

 

Single:  

Es werden nur die vom ersten Sender empfangenen Lichtdaten verwendet. Soll-
ten gleichzeitig von mehreren Sendern Telegramme mit dem eingestellten Sub-
netz und Universe anliegen, wird nur der als erstes er kannte Sender berücksich-
tigt. Die Sender-Erkennung erfolgt bei AVAB/IPX direkt durch Auswertung der 
MAC-Adresse (Ethernetadresse), bei sACN nach der Geräte-ID und bei allen an-
deren Protokollen durch die IP-Adresse des Senders, die für jeden Sender indivi-
duell sein muss. Bei Ausbleiben des Sendersignals wird nach der Timeout-Zeit 
(Pufferzeit) ggf. ein anderer Sender ermittelt (Prinzip: „Der erste darf“). 

 

Merge4: 

Es werden die Daten von bis zu 4 Ethernet-Sendern nach dem HTP-Prinzip zu-
sammengefasst. Sollten gleichzeitig von mehr als 4 Sendern Telegramme mit 
dem Subnetz und Universe dieses Ausgangs anliegen, werden nur die ersten 4 
erkannten Sender berücksichtigt. Bei Ausbleiben eines Sendersignale wird nach 
der Timeout-Zeit ggf. ein anderer Sender ermittelt (Prinzip: „wer zuerst kommt“). 

Universe Einstellung des Sende-Universes (lichtprotokollabhängig) 

Subnet Einstellung des Sende-Subnets (lichtprotokollabhängig) 
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Bei Protokollen mit Prioritäten gibt es folgende Besonderheiten: 

 

Protokoll Prioritätsbehandlung 

AVAB/UDP Bei Priorität  1…200 gewinnt die Anlage mit dem höchsten Prioritätswert. 

Mehrere gleiche der höchsten Priorität werden HTP- gemergt. 

Anlagen, die 0 senden (alte transtechnik-Versionen, DigiPlus usw.) wer-
den immer mit der höchsten Priorität zusammen HTP-gemergt. 

sACN Bei Priorität  1…200 gewinnt die Anlage mit dem höchsten Prioritätswert. 

Mehrere gleiche der höchsten Priorität werden HTP- gemergt. 

Anlagen, die 0 senden, werden wie Priorität 100 behandelt. 

 

DMX 

Dieses Untermenü entspricht dem gleichnamigen Menü Config→DMX. In diesem Menü werden 
das Verhalten der DMX-Out bei Empfangsausfall sowie das Timing des gesendeten DMX-Protokolls 
festgelegt. 

 

 
 

Auswahl Bedeutung 

DMX-Output-
Verhalten 

Off: bei Empfangsausfall wird der DMX-Out abgeschaltet 

Hold: der letzte empfangene Stand wird unverändert weitergesendet 

Zero: bei Empfangsausfall werden Nullen weitergesendet 

Break hat keine Bedeutung 

MAB hat keine Bedeutung 
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Ethernet 

Das Untermenü entspricht dem Menü Config→Network und genauso werden hier die auf dem 
Ethernet basierenden Netzwerkprotokolle eingestellt. 

 

 
 

Auswahl Bedeutung 

Empfangsprotokoll Einstellung des Netzwerkprotokolls für Senden: 

Art-Net 

AVAB/IPX 

AVAB/UDP 

ShowNet 

sACN 

Sendeprotokoll Einstellung des Netzwerkprotokolls für Empfang: 

Art-Net 

AVAB/IPX 

AVAB/UDP 

ShowNet 

sACN 

Licht Timeout Einstellung des Timeouts für den Empfang von Lichtprotokolle  

0…999 s  (0 = letztes Protokoll halten) 

Netzwerk Senderate Einstellung der Mindest-Senderate für Lichtprotokolle, wenn sich keine 
Werte ändern.  

20ms, 40ms, 80ms, 100ms, 200ms, 500ms, 1s, 2s, 3s, 4s 
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Auswahl Bedeutung 

IP Mode Bezug der IP-Adresse: 

Manuell: freie Einstellmöglichkeit 

Art-Net 2: Art-Net-Adresse im 2er Netz 

Art-Net 10: Art-Net-Adresse im 10er Netz 

DHCP:  wenn DHCP-Server im Netzwerk vorhanden 

IP-Adresse wenn Manual: freie Einstellung der IP-Adresse 

sonst:  Schaumodus für die bezogene oder generierte IP-Adresse 

Subnetmaske wenn Manual: freie Einstellung der Subnetmaske 

sonst:  Schaumodus für die bezogene oder generierte   
  Subnetmaske 

Gateway wenn Manual: freie Einstellung der Gateway 

sonst:  Schaumodus für das bezogene oder generierte Gateway 

Richtungssteuerung 

(nur wenn “Einstellung 
Übertragungsmedium 
auf manuell) 

Full:  voller Duplex 

Half:  halber Duplex 

Netzwerk-
Geschwindigkeit 

(nur wenn “Einstellung 
Übertragungsmedium 
auf manuell) 

100 Mbit/s 

10 Mbit/s 

Sendechecksumme On:  Berechnung der Checksumme eingeschaltet 

Off:  Berechnung der Checksumme ausgeschaltet 

Empfangschecksumme On:  Berechnung der Checksumme eingeschaltet 

Off:  Berechnung der Checksumme ausgeschaltet 

Einstellung Übertra-
gungsmedium 

Auto- 

negotiation: automatische Geschwindigkeit und Duplexmodus  

Manuell: manuell definierte Geschwindigkeit und Duplexmodus 
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Optionen 

Im Punkt Optionen finden Sie zuerst vier Informationsseiten über die Hardware, Software, Be-
triebszähler und zum Netzwerk. Darauf folgend können grundlegende Geräteeinstellungen festge-
legt werden. Dieser Teil dieses Untermenüs entspricht dem Menü Options im Gerät. 

 

 
 

Auswahl Bedeutung 

Menü-Timeout Zeit bis Rückkehr vom Menü zum Grundzustand im Gerätedisplay 

Screensaver-
Timeout 

Timeout für Backlight-Abschaltung des Displays  

(OFF, 15s, 30s, 1m, 3m, 5m, 10m, 15m, 20m, 30m, 45m, 1h, 2h, 3h, 4h, 6h, 
8h, 12h, 24h)  

Default Bildschirm Definierung einer dem Grundzustand übergeordneten Anzeige  
 
Scroll:   Grundzustand scrollt normal  
Big Adr:  Anzeige der DMX-Adresse des Dimmerkanals 1  

Big User Text:  Anzeige eines selbstformulierten Textes. Die Eingabe des  
  Textes muss direkt am Gerät erfolgen.  

Display an bei Ände-
rungen 

On: Statusänderungen an DMX-In/Out oder Ethernet schalten Bild-
 schirmschoner aus und zeigen die jeweilige Statusseite an 

Off: Statusänderungen wirken sich nicht auf Bildschirmschoner aus 

Pin Hauptmenü-Pin 

0…30000s (0 = aus) 

Remotesteuerung 
an/aus 

On: MasterPort 2 PSU ist per Art-Net programmierbar 

Off: MasterPort 2 PSU ist nicht per Art-Net programmierbar 

Sende sACN v4 Auswahl des unterstützen sACN-Protokolls  
Off  MasterPort 2 PSU arbeitet mit sACN nach Standard E1.31 R0 Draft 

On  MasterPort 2 PSU arbeitet mit sACN nach Standard E1.31 2009 
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Auswahl Bedeutung 

Art-Net 3 Netzwerk Erlaubt einen ArtNet3 IP-Adressbereich 

Sende Art-Net als 
Broadcast 

Erlaubt die Ansteuerung von ADB-Anlagen 

Kontrast Einstellung des Kontrasts des Displays 

 

 

 

PSU 

Das Menü zur Einstellung der Power-DMX-Ports entspricht den Einstellmöglichkeiten in Con-
fig→PSU im Gerät.  
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Auswahl Bedeutung 

Maximalstrom Einstellung der Schaltschwelle der Laststromüberwachung 

Controlmode PSU Einstellen des Schaltverhaltens  

On:  Servicemodus! Nicht im normalen Betrieb nutzen! 

Sense:  Der Power-DMX-Port wird automatisch abgeschaltet, wenn 
  die eingestellte Begrenzung der Stromstärke oder die  
  maximale Stromstärke von 5A überschritten wird. Die  
  manuelle Einstellung des Grenzwertes wird im Untermenü 
  MaxCurr eingestellt. 

DMX:  Hier wird die DMX-Adresse festgelegt, über die der Power-
  DMX-Port angesteuert wird. Die Stromüberwachung ist  
  aktiv und entspricht den Einstellungen aus "Sense". 

Off:  Der Power-DMX-Port ist manuell ausgeschaltet. 

DMX Kanal Einstellung der DMX-Adresse für die Steuerung des Power-DMX-Port. 

 

 
Der Betrieb mit der Switch-Einstellung „On“ ist ausschließlich für den Service vorge-
sehen! Ein dauerhafter Betrieb mit mehr als 5A Dauerlast kann zur Zerstörung des 
MasterPort 2 PSU und der gesamten Lichtanlage führen! 

 
Einstellung Sense: Wurde die eingestellte Stromstärke überschritten und der Mas-
terPort 2 PSU automatisch abgeschaltet, muss ein manueller Reset unter Opti-
ons→Reset zum Neustart durchgeführt werden. Alle Einstellungen bleiben dabei 
erhalten.  
 

Einstellung DMX: Wurde die eingestellte Stromstärke überschritten und der Mas-
terPort 2 PSU automatisch abgeschaltet, wird die Stromüberwachung durch ein 
kurzzeitiges Aus- und Einschalten des DMX-Kreises aus der Ferne zurückgesetzt. Alle 
Einstellungen bleiben dabei erhalten. 
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MasterPort-Gruppen 

Einführung 

Die MasterPort-Gruppierung ist eine elegante Möglichkeit, Ihre Geräte-Infrastruktur an die aktuel-
len Gegebenheiten wie z.B. unterschiedliche Veranstaltungen oder Aufgaben anzupassen. Master-
Ports, die für eine bestimmte Aufgabe mit ganz konkreten, individuellen Einstellungen gebraucht 
werden, können im Vorfeld schon abgespeichert und bei Bedarf mittels eines Tastendruckes ent-
sprechend programmiert werden. Die Einstellungen werden hierfür auf der Festplatte Ihres PCs als 
XML-Dateien gespeichet.  
 

Wenn Sie diese Methode der Programmierung verwenden, dann sollten Sie sicherstel-
len, dass die gespeicherten Dateien immer ein aktuelles Abbild Ihrer Infrastruktur dar-
stellen. Geräte, die Sie ausgetauscht haben, sollten immer auch in den gespeicherten 
Einstellungen ersetzt werden (Siehe weiter unten).  

 
Zusätzlich bietet die MasterPort-Gruppierung auch eine einfache Backup/Restore-Methode. 
 
 

Neue MasterPort-Gruppe erstellen 

Stellen Sie zunächst alle Geräte für die geplante MasterPort-Gruppe auf die erforderlichen Einstel-
lungen ein. Rufen Sie über das Menü "Extras" den Menüpunkt "MasterPort-Gruppen" auf. 
 

 
 
Klicken Sie auf den Button "neue Gruppe erstellen". 
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Vergeben Sie nun einen aussagekräftigen Namen für Ihre Gruppe. Wählen Sie aus der Gruppe der 
verfügbaren MasterPorts (linke Spalte) Ihre zu gruppierenden Geräte aus. Fügen Sie diese zur 
Gruppe hinzu (">"). Sie können auch Geräte aus der Gruppe wieder entfernen ("<"). Der grüne 
Punkt vor den Listeneinträgen bedeutet, dass diese Geräte erreichbar sind und programmiert 
werden können. 
 

Gruppen speichern 

Sind alle Geräte zusammengestellt, dann können Sie die Zusammenstellung mit dem Button "Spei-
chern" auf der Festplatte abspeichern. Das Speicherformat ist XML. Experten können diese Datei-
en mittels eines XML-Editors einsehen oder auch verändern. Der Dateiname ist 
"LSS_MP_<Name>.xml". Wie alle anderen XML-Dateien befinden sich die MasterPort-Gruppen-
Dateien im Anwendungsordner des LSS-Tools. 
 

Vorhandene Gruppe aufrufen 

Rufen Sie über das Menü "Extras" den Menüpunkt "MasterPort-Gruppen" auf. Wählen Sie Ihre 
Gruppe mittels Doppelklick aus. 
 

Gruppen löschen 

Alte Gruppen können mit der Del-Taste gelöscht werden. Die Listeneinträge verfügen auch über 
ein Kontextmenü, über das sie geöffnet oder gegebenenfalls auch gelöscht werden können. 
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Werkseinstellungen 

Die Werkseinstellungen des MasterPort 2 PSU sind: 

 Netzwerkprotokoll:   Art-Net (Empfang und Senden) 

 IP-Mode:   Art-Net 2er Netz 

 IP Adresse:    gemäß Art-Net Standard (2.x.y.z) 

 Netzwerk-Maske:  255.0.0.0 

 Gateway:   192.168.172.254 

 Mindest-Senderate:  1/s 

 Empfangstimeout:   8 s 

 Routing DMX-Ports 1…4: Subnet 0, Universe 0…3 

 Routing DMX-In:  Ethernet-Senden ON, Priorität 0 

 Routing DMX-Out:  Ethernet-Empfang:  MERGE4 

 DMX-Out Verhalten:  OFF  (Abschalten bei Empfangsausfall) 

 DMX-Out Timing:  Break:  200 µ 

MAB:  20 µ 

 Art-Net ShortName:   LSS MasterPort 2 PSU 

 Art-Net LongName:   MasterPort 2 PSU  (c)2012 LSS GmbH      Version x.xx 

 Bildschirmschoner:  15 min, aus bei Statusänderungen 

 Pinabfrage:   aus 

 Art-Net Fernsteuerung: ein 
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Service 
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Firmwareupdate 

LSS ConfigCore 

Ein Update der Firmware kann nur über Ethernet und die kostenfreie Software LSS ConfigCore er-
folgen. LSS ConfigCore ist als Download auf der Internetseite der LSS GmbH unter www.lss-
lighting.de erhältlich.  

Für ein problemloses Update sollte die aktuellste Version von ConfigCore genutzt werden. 

 

Vorbereitungen 

Um ConfigCore mit einem MasterPort 2 PSU zu verbinden, muss der PC, auf dem ConfigCore aus-
geführt, in das gleiche Subnet gebracht werden, in dem sich auch der MasterPort 2 PSU befindet. 
Die Vorgehensweise zur Änderung von IP-Adressen und Subnets werden vom Anbieter des Be-
triebssystems zur Verfügung gestellt.  

Sehr komfortabel kann ein Update vom LSS FileMaster erfolgen. Auf einem FileMaster ist die Soft-
ware ConfigCore bereits vorinstalliert und der Server befindet sich immer im gleichen Subnet wie 
die MasterPort 2 PSUs. 

 

Verbinden des MasterPort 2 PSU mit ConfigCore 

Befinden sich der PC mit ConfigCore und der MasterPort 2 PSU in einem Subnet und sind mitei-
nander über Ethernet verbunden, wird der MasterPort 2 PSU sofort von der Software erkannt. 
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Firmware updaten 

Um das Update einzuleiten, wird nun der der MasterPort 2 PSU aktiviert und in der Menüleiste 
„Extras“ angewählt. Hier befindet sich der Unterpunkt „Firmware-Update“. 

 

 
 

Nun öffnet sich ein Auswahlfenster, um das Firmwareupdate zu laden. 

 

 
 

Firmwareupdates werden von der LSS GmbH als alf-Dateien zur Verfügung gestellt. Im Namen der 
Datei muss die Gerätebezeichnung und die Versionsnummer genannt sein. 
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Wenn die Update-Datei geöffnet wird, erscheint ein Systembildschirm mit der Frage, ob das Up-
date wirklich durchgeführt werden soll. 

 

 

 
 

 

Nach Bestätigung dieser Frage, erfolgt eine zweite Sicherheitsabfrage. Dazu werden die aktuelle 
Versionsnummer und die Versionsnummer des Updates angezeigt. 
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Wird auch diese Sicherheitsnachfrage bejaht, startet das Update. Dazu erscheint auf der Oberflä-
che von ConfigCore ein Ladebalken. Im Display der Steuereinheit des MasterPort 2 PSU wird 
gleichzeitig das Laden animiert bestätigt.  

 

 
 
 
Wenn das Update geladen wurde, erscheint eine Meldung über den Erfolg des Updates oder über 
einen Fehler beim Laden und Installieren der Datei. 
 

 
 
Nach dem Reset der Steuereinheit ist das Update abgeschlossen. Die Anzeige des Art-Net-
Langnamens des MasterPort 2 PSU kann nach dem Update noch die alte Versionsnummer anzei-
gen. Dies ist normal und ändert sich mit dem nächsten Laden der Default-Werte. Zur Kontrolle der 
geladenen Softwareversion sollte auch der Versionshinweis direkt am Display der MasterPort 2 
PSU-Steuereinheit herangezogen werden. 
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Fehlermeldungen, Update fehlgeschlagen 

Sollte das Update fehlschlagen oder während des Übertragens eine Meldung „Revisionsfehler …“ 
mit der IP-Adresse des MasterPort 2 PSU angezeigt werden, sollten folgende Schritte befolgt wer-
den: 

 

 Prüfen ob die aktuellste Version von LSS ConfigCore genutzt wird. Wenn nicht, bitte das 
Programm updaten. 

 Prüfen ob die zum MasterPort 2 PSU passende Update-Datei geladen wurde. 

 

Sollte trotzdem ein Update nicht möglich sein, setzen Sie sich mit der LSS GmbH in Verbindung. 

 
 

Kontaktaufnahme 

Falls Probleme beim Betrieb des LSS MasterPort 2 PSU auftreten, sollten die Beschreibungen und 
Hinweise in diesem Handbuch zur Fehleranalyse und Fehlerbehebung weiterhelfen. Sollte dies 
nicht der Fall und es werden weiterführende Hilfestellungen benötigt, wenden Sie sich an den LSS 
Service. 

 

Bei der Kontaktaufnahme sollten folgende Informationen vorliegen: 

 

- Ort der Gesamtanlage und Position des MasterPort 2 PSU 

 

- Ausführliche Fehlerbeschreibung 

 

- Ausführliche Beschreibung der bisher erfolgten Fehlersuche 
 

- Beschreibung zusammenhängender System- oder Geräteprobleme 

 

 

Kontaktadresse: 

LSS GmbH 

Licht-, Steuer- und Schaltanlagenbau GmbH 

Am Eichenberg 1 

D-04600 Altenburg 

Tel.: +49 3447 83550 

Fax: +49 3447 861779 

mail@lss-lighting.de 
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Anhang A 

Besonderheiten der Netzwerkprotokolle 

Die Netzwerkeinstellungen (IP-Mode, IP-Adresse, Netzwerkmaske) des MasterPort 2 PSU wirken 
sich bei den verschiedenen Lichtprotokollen unterschiedlich aus: 

 

Licht-
Protokoll 

IP-Besonderheiten 

Art-Net IP-Mode, IP-Adresse und Netzmaske wirken sich direkt auf Art-Net aus. Aus Kompa-
tibilitätsgründen sollte immer der automatische IP-Mode „Art-Net2“ verwendet 
werden. 

Z.B. kommen DMX-Workshop oder GrandMA nur mit dem 2er Netz klar. 

AVAB/IPX IP-Mode, IP-Adresse und Netzmaske wirken sich überhaupt nicht auf AVAB/IPX aus, 
da dieses ein Novell-Protokoll ist. 

Der MasterPort 2 PSU kann aber trotzdem remote über Art-Net konfiguriert wer-
den, dafür sind IP-Mode, IP-Adresse und Netzmaske relevant  -zur Kompatibilität 
auch hier am besten „Art-Net2“ verwenden. 

AVAB/UDP IP-Mode, IP-Adresse und Netzmaske wirken nicht auf AVAB/UDP aus, da AVAB/UDP 
mit  Broadcasts arbeitet. 

So kann man auch hier am besten die Defaulteinstellung „Art-Net2“ verwenden und 
damit auch hier immer den MasterPort 2 PSU über Art-Net remote konfigurieren. 

ShowNet IP-Mode, IP-Adresse und Netzmaske wirken sich auf ShowNet aus.  

Häufig wird 192.168.0.x oder 192.168.1.x verwendet. Die Netzwerkmaske sollte 
255.255.255.0 sein.  

Um dies einstellen zu können, muss der IP-Mode „Manuell“ sein (oder DHCP, falls es 
einen entsprechenden DHCP-Server im Netz gibt). 

Der MasterPort 2 PSU kann trotzdem remote über Art-Net konfiguriert werden, al-
lerdings beherrscht nicht jede Fremdsoftware Art-Net mit derart abweichenden IP-
Adressen. 

sACN IP-Mode, IP-Adresse und Netzmaske wirken sich nicht auf ACN aus, da ACN ein Mul-
ticast-Protokoll mit der IP 239.255.x.y ist. Dieses wird unabhängig empfangen. 

So kann man auch hier am besten die Defaulteinstellung „Art-Net2“ verwenden und 
damit auch hier immer den MasterPort 2 PSU über Art-Net remote konfigurieren. 
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Die einstellbaren Parameter Subnet und Universe unterscheiden sich wie folgt: 

 

Protokoll Universe Subnet Besonderheiten 

Art-Net 0…15 0…15 Der MasterPort 2 PSU kann auf jedem einzelnen DMX-Port mit 
verschiedenem Subnet und Universe arbeiten. 

Dies ist z.B. mit dem DMX-Workshop nicht einzeln einstellbar, 
nur mit dem LSS-Softwaretool. 

AVAB/IPX 1…12 0…9  

AVAB/UDP 1…32 0…9 Bei DMX-IN: Sende-Priorität 0…200 einstellbar. 

ShowNet 1…36 nicht 
vorhand
en 

Bei ShowNet gibt es eigentlich keine Universes,  alle Dimmer-
daten werden in einem 18432 Kreise großen Feld dargestellt. 
In älteren Anlagen (5xx) konnte man dies auch konfigurieren. 

Trotzdem hat sich in der Praxis die Einteilung in Vielfache von 
512 durchgesetzt (wegen DMX). 

Der MasterPort 2 PSU verhält sich beim Einstellen des Univer-
se wie neuere Anlagen von Strand Lighting: hier stellt man nur 
noch Vielfache von 512 ein, „XDMX Nr.“ genannt. „Krumme“ 
Adressen sind nicht möglich. Die realen Kreisnummern von 
1…18432 werden im Routing zusätzlich angezeigt.  

sACN 1… 65279 nicht 
vorhand
en 

Die Universe-Nummer kann frei eingestellt werden und bildet 
sich in der Multicast-IP-Adresse ab. 

Subnets werden nicht benötigt. 

Bei DMX-IN: Sende-Priorität 0…200 einstellbar. 

 

Prioritäten bei der Wahl des Lichtprotokolls 

Bietet eine Anlage mehrere Lichtprotokolle zur Auswahl, so sollte vom Standpunkt der Netzwerk-
belastung die Rangfolge sein: 

1. sACN 

2. Art-Net 

3. ShowNet 

4. AVAB/UDP 

5. AVAB/IPX 
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Konfiguration für die verschiedenen Lichtprotokolle 

Art-Net 

Da Art-Net die Defaulteinstellung ist, brauchen Sie hierfür an den Netzwerkeinstellungen nichts zu 
verändern. 

Der Empfangstimeout ist 8s, die Senderate ist 1s. 

Das Default-Subnet ist 0 und die Universes 0…3 für die 4 DMX-Ports (egal ob diese In oder Out 
sind). Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…4 ein. Dort 
schalten Sie die Ports auch einzeln ein oder aus. 

 

Per Default hört der MasterPort 2 PSU auch auf Art-Net-Softwaretools und andere Anlagen. 

 

AVAB/IPX 

Schalten Sie den Empfang des Netzwerkprotokolls AVAB/IPX unter Config→Network→Light→ 

Receive ein. Stellen Sie den Empfangstimeout auf 3s. 

 

Schalten Sie das Senden des Netzwerkprotokolls AVAB/IPX unter Config→Network→Light→ 

Transmit ein. Stellen Sie die Senderate auf 0,5s. 

 

Das Default-Subnet ist 0 und die Universes 1…4 für die 4 DMX-Ports (egal ob diese In oder Out 
sind).Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…4 ein. Dort 
schalten Sie die Ports auch einzeln ein oder aus. 

Per Default hört der MasterPort 2 PSU auch auf Art-Net-Softwaretools und andere Anlagen. 

 

AVAB/UDP 

Schalten Sie den Empfang des Netzwerkprotokolls AVAB/UDP unter Config→Network→Light→ 

Receive ein. Stellen Sie den Empfangstimeout auf 3s. 

 

Schalten Sie das Senden des Netzwerkprotokolls AVAB/UDP unter Config→Network→Light→ 

Transmit ein. Stellen Sie die Senderate auf 0,5s. 

 

Das Default-Subnet ist 0 und die Universes 1…4 für die 4 DMX-Ports (egal ob diese In oder Out 
sind). Die Default-Sendepriorität ist 0 (entspricht höchster, immer mergen). Andere Subnets 
und/oder Universes stellen Sie unter Config→Routing→Port1…4 ein. Dort schalten Sie die Ports 
auch einzeln ein oder aus. 

 

Per Default hört der MasterPort 2 PSU auch auf Art-Net-Softwaretools und andere Anlagen.  
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ShowNet 

Schalten Sie den Empfang des Netzwerkprotokolls ShowNet unter Config→Network→Light→ 

Receive ein. Empfangstimeout ist 8s. 

 

Schalten Sie das Senden des Netzwerkprotokolls ShowNet unter Config→Network→Light→ 

Transmit ein. Stellen Sie die Senderate auf 4s. 

 

Die Default-Universes (XDMX) sind 1…4 für die 4 DMX-Ports (egal ob diese In oder Out sind). 

Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…4 ein. Dort schal-
ten Sie die Ports auch einzeln ein oder aus. 

Per Default hört der MasterPort 2 PSU zwar auf Art-Net-Softwaretools, aber nicht jedes kommt 
mit den 192.168er IP-Adressbereichen klar. 

 

sACN 

Schalten Sie den Empfang des Netzwerkprotokolls sACN unter Config→Network→Light→Receive 
ein. Stellen Sie den Empfangstimeout auf 3s. 

 

Schalten Sie das Senden des Netzwerkprotokolls sACN unter Config→Network→Light→Transmit 
ein. Stellen Sie die Senderate auf 0,5s. 

 

Die Default-Universes sind 1…4 für die 4 DMX-Ports (egal ob diese In oder Out sind). Die Default-
Sendepriorität ist 0 (entspricht 100).Andere Subnets und/oder Universes stellen Sie unter Con-
fig→Routing→Port1…4 ein. Dort schalten Sie die Ports auch einzeln ein oder aus. 

 

Per Default hört der MasterPort 2 PSU auch auf Art-Net-Softwaretools und andere Anlagen. 
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Anhang B 

Technische Daten 

Allgemeine technische Daten 

Bauart: Panel-Einbaugerät 
 

Gerät Abmessung Gewicht 

Einbaugerät für Gehäuse 130 x 68 x 155mm Ca. 0,7kg 

Einbaugerät für LSS Dimmerkanäle 130 x 68 x 150mm Ca. 0,7 kg 

Einbaugerät für Aufputzgehäuse 200 x 76 x 155mm Ca. 3,0kg 

Portable mit Schutzbügel 215 x 213 x 175mm Ca. 4,5kg 

 
EMV-Standards: EN 55022, class B, FCC part 15, level B 
RoHS: konform 
Lieferumfang: Fertiggerät 
 
CPU-Typ: Infineon XE167 
Taktfrequenz: 80 MHz 
Kühlung: lüfterlos, passiv 
Stromversorgung: 24V DC oder PoE nach IEEE 802.3af 
Leistungsaufnahme: 
Konfiguration: Menüsystem mit Display und Encoder 
 

Stromversorgung PSU:   24V DC  

Betriebstemperatur: 0° - 40°C 
Leistungsaufnahme: 7- 14W 
 
 

Netzwerk 

DMX 

Allgemein 
DMX-Protokoll: DMX-512  
Standards: USITT 1990, DIN 56930-2, ANSI E1.11 
Baudrate: 250 kbps 
DMX: Frontseite:  4x 5pin XLR female 
   einzeln potentialgetrennt mittels  
   Optokoppler  
   (ISOLATED nach ANSI E1.11 A1) 
 Rückseite: 4x 4pin XLR Sockel male 
   Ohne Potentialtrennung!  
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Power-DMX: Frontseite: 4x 4pin XLR femal 
   einzeln potentialgetrennt mittels  
   Optokoppler  
   (ISOLATED nach ANSI E1.11 A1) 
 Rückseite: 4x 4pin XLR Sockel male 
   Ohne Potentialtrennung 
 
Max. Laststrom pro Anschluss: Frontseite: 5A 
 Rückseite: 3A 
  
Isolationsspannung:    1000V DC 

Isolationswiderstand:    109  
EMV: Filterbeschaltung nach Stand der Technik an allen Ein- 

und Ausgängen 
Terminierung: werksseitig intern 
 

Empfang 

Startcode: =0    Lichtprotokoll (in Display ●) 

 <>0  kein Lichtprotokoll, RDM (in Display  E) 
minimale Protokollänge: nur Startcode 
maximale Protokollänge: Startcode + 512 Werte 
 (Werte über 512 gehen verloren) 

minimale Durchlaufverzögerung: 44 s 
maximale Durchlaufverzögerung: 22,5 ms 
Empfangstimeout: 2 s 
max. Abstand zwischen 2 Protokollen: 2 s 

Minimale erkannte Breaklänge: 48 s 
Maximal zulässige Breaklänge: 1,95 s 
 

Senden 
Startcode: 0 
Protokollänge: Startcode + 512 Werte 
Minimale Protokollzeit: 22,4 ms 
Gesendete Protokolle / s: 44 
Breaklänge: 90…999 µs (einstellbar) 
Mark After Break: 20…999 µs (einstellbar) 
Pause nach Startcode: 25 µs 
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Ethernet 

Allgemeines 
Schnittstelle:  RJ-45, IEEE-Belegung für 100BaseTx und Power-over-

Ethernet nach IEEE 802.3af 
Geschwindigkeit: 10 MBit/s, 100MBit/s; Autonegotiation 
Duplex-Mode: halb, voll; Autonegotiation 
 Auto-MDI/MDIX 
Anzeige: Link-LED, Data-LED, Geschwindigkeit und Duplex-Mode 

werden im Display angezeigt 
Lichtprotokolle: Art-Net (ArtisticLicence) 
 AVAB-IPX (AVAB, transtechnik, LDDE,…) 

 AVAB/UDP (transtechnik) 
 ShowNet (Strand Lighting) 

 sACN (ANSI E1.31) 
weitere Netzwerkprotokolle: ARP, IP, IPX, UDP, IGMPv2 
 

Empfang 
Maximale Paketrate: >1000/s (bei 1 Lichtframe/Paket) 

Minimale Durchlaufverzögerung: 4 s 
Maximale Durchlaufverzögerung: 22,7 ms 
Max. Abstand zwischen 2 Protokollen: 1...999 s  (Halten per DMX-Out einstellbar) 
 
 

Senden 
Senderate bei Wertänderung: maximal aller 20 ms 
Senderate ohne Wertänderung: 20 ms … 4 s  (einstellbar) 
 
  



MasterPort 2 PSU 

74 

   

 

 

Anschlussbelegung 

DMX Ports 

DMX Frontseite 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 DMX_Ground 

2 Data - 

3 Data + 

4 Spare 

5 Spare  

 

PE kann über die Schirmung geführt werden 

 

DMX Rückseite 

 

Pin Belegung 

1 DMX_Ground 

2 Data - 

3 Data + 

4 Spare 

 
 

Power-DMX Frontseite 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Ground 

2 Data - 

3 Data + 

4 +24V DC 

 

PE kann über die Schirmung geführt werden 
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Power-DMX Rückseite 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Ground 

2 Data - 

3 Data + 

4 +24V DC 

 

PE kann über die Schirmung geführt werden 

 

 

Ethernet 

Der Ethernet-Anschluss unterstützt Power-over-Ethernet nach IEEE 802.3af 

 

Pin Belegung 

1 Rx + 

2 Rx - 

3 Tx + 

4 V + 

5 V + 

6 Tx - 

7 V - 

8 V - 

S Kabelschirm 

 
 

Bestellnummer 

5063:       4x DMX-OUT 


